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Background

ResCarta® standards for scanning and naming conventions:

Please review the following requirements for digital documents to determine how to scan, photograph,
and name your images; your data must meet these requirements for the tools of the ResCarta Toolkit to
function properly:

e Scan book pages as any of the following:

o Bitonal, 600 DPI, G4 compressed TIFF files (suitable for pages containing mostly text, half-
toned photographs, and etchings).

o Grayscale, 300 DPI, 8-bit, uncompressed TIFF files (suitable for pages containing mostly
black-and-white continuous tone images).

o Color, 300 DPI, 24-bit, uncompressed TIFF files (suitable for pages containing spot color or
color images).

e Save all images using a unique, sequential naming convention. For example, 00000001.tif,
00000002.tif, 00000003.tif, etc.

e Save all images that represent a particular document in the same directory, and store all
directories that represent your documents under the same “parent” directory. For example, the .tif
images in the preceding example might be stored in a book0001 (document) directory, which
would then be stored in another directory (the “parent” directory in which all documents are
stored).

The ResCarta Toolkit also works with TIFF, JPEG, PDF (image only), PDF (image and text) and PDF
(Normal/Text) files.

Note: The requirements here are a summary of the complete standards, which are available at the
ResCarta Foundation’s website: http://www.rescarta.org

Scanning Parent Directory

Photo-directory
00000001.jpg
00000002.tif
00000003.jpg
00000004.jpg

book0001-directory
00000001.pdf
00000002.pdf

00000224.pdf
00000225.pdf
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Overview

How the ResCarta Toolkit works with ResCartaWeb:

ResCartaWeb is a customizable web site with the ability to display and search a database of ResCarta
objects. The ResCarta Toolkit allows you to create, manage, manipulate, and check the ResCarta-
formatted data accessed by ResCartaWeb, as well as add books or objects from your ResCarta database.

Before you install the tools, make sure you have the correct Java Runtime Environment (see page 3).
Also, uninstall any older versions of ResCarta tools you may have on your system.

There are six tools in the complete ResCarta Toolkit. Using these tools will help you create a standard
archive of data that you can view and search using ResCartaWeb or import into other web discover-
display systems. You may need to use all six or just a few of the tools, depending on what you want to
accomplish.

For new images that you’ve digitized and are adding to your ResCarta database, you will need to use
tools that will convert images into ResCarta format. Specifically, you will need to use the ResCarta
Metadata Creation Tool (see page 6) and the ResCarta Data Conversion Tool (see page 11).

For images that have not been OCRed, or for images to which you want to add searchable text
(photographs, maps, etc.), you will need to use the ResCarta Textual Metadata Editor (see page 15) so
that these images will be searchable with ResCartaWeb.

Whenever you make any change to your ResCarta database, (e.g., adding books or collections, images,
changing the metadata, etc.), you must manage that change by using the ResCarta Collections Manager
(see page 19) as well as index any changes by using the ResCarta Indexer. The ResCarta Collections
Manager allows you to add and delete titles and edit metadata. The ResCarta Indexer (see page 26)
insures that the new data you’ve added is added to the index so that when you use ResCartaWeb’s search
function, the new data will be searchable, along with the older data.

To verify the integrity of your data, you will want to use the ResCarta Checksum Verification Tool (see
page 29). This tool, used after data has been converted to the ResCarta format, compares computed values
of data to ensure accuracy.

The tools included in the ResCarta Toolkit do not have to be installed on the same computer on which
your ResCarta database is stored, or on your ResCartaWeb server computer (regardless of whether the
two are located on different machines). However, the computer on which you install the tools should have
network access to the ResCarta database, to transfer digital objects to the ResCarta database after they’ve
been converted to ResCarta format and edited as needed.

Note: The ResCarta tools and ResCartaWeb can be downloaded from the ResCarta Foundation’s website:
http://www.rescarta.org
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Installing the ResCarta Toolkit

You can install any or all of the tools in the ResCarta Toolkit at any time. The tools are not required to be
installed on the computer on which your ResCarta database is stored, or on your ResCartaWeb server
computer (regardless of whether the two are located on different machines), but the computer on which
the tools are installed should have network access to the ResCarta database computer. Before installing
the ResCarta Toolkit, be sure that the computer on which you intend to install the toolkit meets the
requirements for installation.

Note: While the ResCarta Toolkit may be installed on other operating systems, such as Apple® Mac OS®
X , Red Hat® Linux® or Ubuntu; using the InstallRcTools_# # #.jar file, information in this document is

specific to Windows systems. For information on installing the ResCarta Toolkit on other operating
systems, please contact the ResCarta Foundation at info@ResCarta.org

Requirements for installing the ResCarta Toolkit:

e 1GBRAM

Note: 1 GB is the required amount of RAM for use with the ResCarta Toolkit; 2 GB or more
RAM is recommended, especially for use with larger volumes of data (500,000 images).

e Sun® Microsystems Java™ Runtime Environment (JRE) 1.6.0 or greater

Note: The latest version of the JRE is always recommended, and can be downloaded from the
Java website at: http://www.java.com

Tip: To determine whether a machine already has a JRE installed, from the Windows Start menu,
select Settings, and then select Control Panel. Control Panel opens. If Java is installed, it will
appear in the list. Double-click Java to open the Java Control Panel, and on the General tab,
click About. The About Java window appears. If the version of the installed JRE is 1.5.0 or
greater, you are ready to install the ResCarta Toolkit (see page 4); if not, you must first install the
JRE (see next procedure).

o If you wish to convert Normal PDF files, you will need to download Ghostscript 8.70 or later
from http://pages.cs.wisc.edu/~ghost/ or http://sourceforge.net/projects/ghostscript/.

To install the Java Runtime Environment (JRE):

Note: It is strongly recommended that you exit all Windows programs before installing the JRE.

6. Open Windows Explorer, navigate to the JRE’s executable installation file, and then double-click it.

7. The InstallShield Wizard appears, preparing to guide you through the Java platform installation
process.

Note: You can cancel the JRE installation at any time before it’s complete by clicking Cancel in any
of the installation windows. After you click Cancel, a Setup window opens to confirm that you want
to cancel the Java installation process (click Yes to cancel the JRE installation, or click No to return
to the installation).

8. The License Agreement window appears. Read the information in this window carefully, and then
select the type of Java setup you want to use. You must accept the agreement to continue the Java
installation.
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Note: The ResCarta Foundation recommends Typical setup for use with the ResCarta ToolKkit.
Click Accept to continue.

The Installing Java 2 Runtime Environment window appears for the specific version of the JRE
you’re installing, and Java installation begins. When installation is complete, the Installation
Complete window appears.

Click Finish to complete the installation process.

Note: You may be notified that you need to restart your computer; in that case, you will be given the
opportunity to reboot immediately or at a later time. You may select either option, but be sure to
reboot before beginning to install the ResCarta ToolKit.

To install the ResCarta Toolkit:

After you’ve confirmed that the JRE version 1.6.0 or greater is installed or have completed the installation
process, you are ready to install the ResCarta Toolkit. You may install all the tools included in the
ResCarta Toolkit or a selection. Complete the following installation sequence for the tools that you want
to install.

Important! If you’re installing an updated version of one or more of the tools in the ResCarta Toolkit, you
should uninstall the older version of the tool(s) before installing the newer version. For more information
on uninstalling these tools, refer to Uninstalling the ResCarta Toolkit (see page 31).

Note: It is strongly recommended that you exit all Windows programs before installing the ResCarta
Toolkit.

1.

Open Windows Explorer, navigate to the Toolkit’s executable installation file, and then double-click
the file.

Note: The full file name of the executable file contains numbers and underscores immediately
preceding the .exe extension. This portion of the file name represents the version number of the tool,
and is not included in this reference document.

The 1zPack Wizard appears, preparing to guide you through the installation process for the tool you
selected.

Note: You can cancel the installation of any of the tools at any time before it’s complete by clicking
Cancel in any of the installation windows. After you click Cancel, a Setup window opens to confirm
that you want to cancel the installation process (click Yes to cancel the installation of the tool, or click
No to return to the installation).

The Setup Wizard’s Welcome window opens. Read the information in this dialog and click Next to
continue. You will be asked to accept the terms of the applicable licenses. Click “I accept” and next
to continue.

The Setup Wizard’s Select Destination Directory window opens. Select the folder in which you want
to install the tools.

Note: The default destination directory for the tools included in the ResCarta Toolkit is as follows:
C:\Program Files\RcTools

To select a different destination directory, enter the path to the folder in which you want to install the
tools or browse to the desired installation location. On Vista, you may install into your personal
directory since the installer is not allowed to install into the \Program Files area.

Click Next to continue.



6. Select installation packages from the next dialog box. Select the tools you wish to install on your
computer system by clicking on the checkboxes. Press the Next button to continue.

@ [zPack - Installation of The ResCarta Toolkit | o ]

Select Installation Packages m‘s QRI
Step 4 of 7

Select the packs you wank to install;
Mote: Graved packs are required.

= 12,21 ME
¥ Metadata Creation Toaol 1,0,9 90,23 KB
[¥ Data Corversion Tool 1,1.1 1.66 ME
¥  Textual Metadata Editor 1.0.6 63.53 KB
¥ Callections Manager 1.5.1 132.26 KB
W Indexer 1.6.5 113.61 KB
¥ Checksurm Yerification Tool 1,0.3 50.21 KB
[¥ DataFormat Update Tool 1.0.1 50,76 KB
¥ Documentation 960,74 KB
Description

The base files

Total space Required: 15,29 ME
Available space: 29 Gh

Prewvious | ik |

(Ml ade with |zFack - hitp:fizpack.orgh

7. The Setup Wizard’s Installing window opens and installation begins. The installation progress bars
will show the individual and overall progress of the installation. After completion of the installation,
the installer will ask if you want start menus and if the software should be set up for your user or all
users of this system. On Vista, you can exit at this point, no shortcuts will be created.

Note: The default Start menu folder for all of the tools included in the ResCarta Toolkit is ResCarta
Tools.

To select a different Start Menu folder, enter the name of the folder in which you want to display the
tool’s shortcuts, or browse to the desired display location.

Click Next to continue.
8. When installation is complete, the Setup Wizard’s Completing window opens.
Click Done to close the Setup Wizard window and exit setup.

After you’ve completed the installation for each of the six tools, the ResCarta Toolkit is completely
installed and ready for use.



ResCarta Metadata Creation Tool

Use the ResCarta Metadata Creation Tool to create document metadata (information about your
images that’s stored with them in a digital format). Any new, digitized document that you create for
inclusion in your ResCarta database needs document metadata in order to be recognized by ResCartaWeb.

To create metadata in “Document per Directory” mode:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4, and then select ResCarta
Metadata Creation Tool.

Note: The version number of the ResCarta Metadata Creation Tool is also included as the last part
of its Windows Start menu option name, but is not included in this document.

The ResCarta Metadata Creation Tool appears.

EArescarta Metadata Creation Tool ¥1.0.9 ) o =]
File Mode
Objects
Object wiew
iTltIe - !

From the Mode menu, select Document per directory.
From the File menu, select Open image data directory.
The Select directory dialog appears.

4. Enter or browse to the directory in which the images for which you want to create metadata are stored
and click Select directory. _

Note: Because the ResCarta Standard requires that all images representing a particular document are
stored in the same directory and all directories representing documents are stored under the same
“parent” directory, enter or browse to that parent directory to work with any or all of the documents
included within it.

5. The Image data directory opened window appears to inform you how many subdirectories
(representing documents) were found within the parent directory you selected. Click OK to continue.

6. The ResCarta Metadata Creation Tool now displays a list of documents within the parent directory
you selected (in the left pane) and displays metadata associated with the current document (in the
right pane).



Note: Documents are listed by their directory location and file name until Title metadata is assigned
Documents for which no metadata has been created are indicated with an exclamation point icon: £

Documents for which metadata exists are indicated with a book icon: &%

Tip: You can view the entire directory location and file name (for documents for which no metadata
has been created) or title (for documents for which metadata already exists) of any item in the
Documents list by briefly pausing your mouse pointer over the item; the complete directory location
and file name or title appears next to your mouse pointer.

To select a document, click its name in the Documents list. Any available metadata for that document
is listed on the right.

&l
To view images for the current document, click View images. An image viewer appears,
displaying the first image in the current document. This viewer includes many of the same viewing
options that are available in ResCartaWeb’s viewer:

SRR IR Il

Refer to ResCartaWeb’s Help for more information on using these viewing options.
A few of the viewer options do not exist within ResCartaWeb:

BBnk

These options are, respectively, Best fit (displays the image at the height and width that are
proportionally sized to fit the viewer), Fit to width (displays the image at the largest width that fits
viewer), Fit to height (displays the image at the largest height that fits the viewer), and Go to page
(opens a dialog for you to select a specific image in the document to view).

When you’re finished viewing the images within the document, click the viewer’s close window
button.

To create new metadata for the current document, click Create metadata. |7 Create metadata_|

Note: If metadata already exists for the current document, the Create metadata button is not
available; use the Modify metadata button to modify the existing metadata.

Shared or local Identifiers: From the File menu, select Preferences and click the Shared file
radiobutton. This will set the location of the file to store your identifiers. It can be a local user or
a network shared location. If you have started using ResCarta tools alone and want to share the
information with a team, select Shared File, enter or browse for a network location where you
and your team have write permission and then press Synchonize with User Configuration this
will allow you to share your existing Instituion Identifiers and coordinte your team.

e The Select source institution dialog appears. Select the source institution you want to use and
click Ok.

X - - "
COTTE—— x PT———
Object id source
) User configuration (8 Shared file = Add
Shared object id file directory
A0 nmi_infR Cids il
[ Bynenronize with User Configuration |
o | concar_|
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To add a new source institution, click Add. The Add institution dialog appears. Enter the Id
for your source institution (8 character alpha-numeric), enter the full Name of your source
institution (optional), and click Finish.

Add institution

| |

Name | |

| Finish | | Cancel |

Important! The source institution identifier must be eight characters (letters and/or numbers)
in length. You can use multiple source institution identifiers with your ResCarta collections,
but a source institution identifier is required for each document. To avoid collisions when
sharing data with other institutions, this identifier must be unique to your institution. If your
institution has a code in the MARC Code List for Organizations, we recommend that you use
that code, padded to the right with zeroes for a total of eight characters, as the source
institution identifier. For example, the MARC code for the New York Public library is NN;
therefore, the recommended source institution identifier for the New York Public Library is
NNO000000, Rescarta’s MARC code is WiOnRFI which is normalized to wionrfiO.

To modify an existing source institution, select the institution you want to change and click
Modify. The Modify institution dialog appears. Change the Id and/or Name of the source
institution as needed and click Finish.

Modify institution :

Id |br00khav |

Name|Elr00khaven Fress |

| Finish | | Cancel |

To remove a source institution, select the institution you want to remove and click Remove.
The Confirm institution removal dialog appears. Click OK to remove the source institution;
click Cancel to cancel the institution removal process.

The Select aggregator and root id dialog appears. Enter the Aggregator and Root id you want to
use and click Ok.

Select aggregator and root id

Aggregator (00000001 |

Rootid [00000001 |

| Ok | | Cancel |

Important! The aggregator and root identifier must each be eight characters (letters and/or
numbers) in length. An aggregator and root identifier are required for each document in your
collection.

Note: Collectively, the source institution identifier (1d), aggregator (Aggregator), and root
identifier (Root id) that you just specified comprise the object identifier, which must—in
combination—be unique for each object, so that it can specify the location of that object. This
directory structure (institution identifier/aggregator/root identifier) is referenced throughout the
ResCarta Toolkit.



e The Select metadata type dialog appears. Select the type of the current document (Monograph,
Serial monograph, or Serial) and click Ok.

Select metadata type

|Monograph | - |

| Ok | | Cancel |

e The Create monograph metadata, Create serial monograph metadata, or Create serial metadata
dialog appears, depending on the type of metadata you selected for the current document; the
Create monograph metadata dialog is shown here:

Create monograph metadata
rMonograph &=
Title
I
Abstract- =
-Alternative titles
=8 Add
rAuthors-
& Add | % modity
Owner
| - :

Note: A Title is required to add metadata to a document; if you are adding serial monograph or
serial documents, a Volume is also required. The ResCarta Foundation recommends completing
as much metadata as possible for all documents in your collection.

Information that you can enter includes: Title, Volume (for serial monograph or serial documents
only), Abstract,Alternative titles, Authors, Owner, Type of resource, Genre, Publisher
name, Place of publication, Publication date, Capture date, Language, Size, Note, Subjects,
Issues, and Pages.

Note: Creating, changing, or removing metadata for Alternative titles, Authors, and Subjects
requires the use of the Add, Modify, and Remove buttons, respectively. These buttons appear
directly below the section for which they’re used. An image viewer is included in the Pages
section for convenient page reference; the Modify page metadata button at the bottom of this
section accesses the Modify page metadata dialog for renaming pages.

Tip: The Publication date and Capture date must be specified in one of the following, three ISO
formats, where YYYY is the year (four-digit format), MM is the numeric value of the month (in
two-digit format), and DD is the day (also in two-digit format): YYYY-MM-DD, YYYY-MM,
orYvyyy.

o Click Finish to save your changes; click Cancel to close the Create monograph metadata, Create
serial monograph metadata, or Create serial metadata dialog without saving your changes.

10. To modify existing metadata for the current document, click Modify metadata. | Modiy metadata |




Note: If no metadata exists for the current document, the Modify metadata button is not available;
use the Create metadata button to create new metadata.

11. To remove all metadata from the current document, click Remove metadata. | X Remove metadata | The
Confirm metadata removal window appears. Click OK to remove all metadata from the current
document; click Cancel to cancel the metadata removal process.

Note: If no metadata exists for the current document, the Remove metadata button is not available.
12. When you’re finished creating metadata, click the ResCarta Metadata Creation Tool’s close

window button. 2 The confirm exit window appears. Click OK to exit; click Cancel to return to the
ResCarta Metadata Creation Tool.

Note: Document metadata is saved in the metadata.xml file, in the directory in which the image files
for that document are stored. This metadata is saved in the METS (Metadata Encoding &
Transmission Standard) format. For more information about METS, refer to the METS website at the
Library of Congress: http://www.loc.gov/mets/

To create metadata in “Document per file” mode:

From the Windows Start menu, select Programs, then select the Start Menu folder that you specified
during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Metadata
Creation Tool.

The ResCarta Metadata Creation Tool appears.

1. From the Mode menu, select Document per directory.
2. From the File menu, select Open image data directory.
3. The Select directory dialog appears.

4,

Enter or browse to the directory in which the images for which you want to create
metadata are stored and click Select directory. _
This will allow you to add a metadata.xml file for each file in the directory. You can apply individual

metadata elements to each file. This is primarily used for multipage PDF file conversion. Proceed as with
step 5 above to produce metadata files.

[ C:'customer', jobs' krc',govDocs - ResCarta Metadata Creatiol o ] 1|
File Mode

Objects Metadata for this document has not yet been

& 23486.pdf [+] :| created. You may create metadata now by

& 54247.puf F | clicking the button below.

& disaster_areas_09082005 / Create Metadata
= mf_properties_in_disaste|
& mm5509.pdf

& Possition Essay Jessica = E
4] li | [v] | :
7 objects |

e

Object wisw

T 1l | =
|Title |v= :

| fie
i7 11

&

Multiplage PDF files in a single directory.
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ResCarta Data Conversion Tool

Use the ResCarta Data Conversion Tool to convert your TIFF, JPEG, PDF (image only), and PDF
(image and text) into ResCarta archive data format. Any new, digitized document that you create for
inclusion in your ResCarta database needs to be converted into this format in order to be recognized.

To convert your images into ResCarta format:

1.

From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta
Data Conversion Tool.

Note: The version number of the ResCarta Data Conversion Tool is also included as the last part of
its Windows Start menu option name, but is not included in this document.

The ResCarta Data Conversion Tool appears.

(B cccorto ot Converson ool i o]
Source data directory Destination directory
QIRCphotosia ] ‘carcoaTan -

Source data type

|Ducu||mr|| per file i - ‘

Source metadata type Default metadata
|Apply default metadata to all documents | b 1 Monograph
Institution id Aggregator and starting root id

|hrockhay |[.]]| | ngaregator [20101203 | Rootid [noooo00Y |
Misc options Serial options

[_] Read PDF title [ Show ghostscript output

[ |Read PDF author [ | Show datefime

[_] Comvert PDFs to color [Jincrement volume ] Incyeeme

Error handling

[v] Continue on error [v] Write error log [v] Separate problem documents

 Begin Conversion

Status

Click the button to the right of the Source data directory text field to specify the directory in which
your source documents are located. [~

The Select directory dialog appears.

Enter or browse to the Source data directory (the directory in which the documents you want to
convert are stored) and click Select directory.

Note: Because the ResCarta Standard requires that all images representing a particular document are
stored in the same directory and all directories representing documents are stored under the same

“parent” directory, enter or browse to that parent directory to work with any or all of the documents
included within it.

Click the button to the right of the Destination directory text field to specify the directory into which
your converted documents will be placed. [ - |

The Select directory dialog appears.
Enter or browse to the Destination directory (the directory into which the converted documents will
be placed) and click Select directory.

11



Important! The destination directory can be located wherever you specify, but it must exist at the time
you begin the conversion process, and it must be named RCDATAOL (upper case).

Safety Note: Do not use your ResCarta database (the intended final location of your data) as your
destination directory; use an intermediate location during the conversion process, and then transfer
converted data from this intermediate location to your ResCarta database.

Select the Source data type as Document per directory from the pull down and select the Source
metadata type as ResCarta Mets.

Note: The Source metadata type for Documents per directory is currently restricted to ResCarta

METS. Future versions of the ResCarta Data Conversion Tool will include support for other source
metadata types.

7. Enter the name of the Source metadata filename as metadata.xml, and click Begin conversion.

| (¥ Begin conversion |

Note: If you created metadata using the ResCarta Metadata Creation Tool (see page 6), the source
metadata filename is metadata.xml; if the source metadata filename you specify does not exist in a
document directory, the conversion process will fail.

The progress of the conversion process is detailed in the Status (lower) section of the ResCarta Data
Conversion Tool, and you will be notified when the process is complete.

ResEarta Data Conversion Tool v1.1.1

T =loix|

Source data directory Destination directory-

Source data type

Source metadata type Source metadata filename

| X cancel Conversion

Status

Starting conversion operation: Dec 3, 2010 8:40:11 A

Reading 2\RCphotost3.. (Finished)

Found 1 documents to canvert.

Converting QIR Cphotosi8 {1 of 1),
Reading source metadata 2R Cphotosi8imetadata xml..(Finished)
Wiriting ResCarta imange data

| Y

Note: Depending on the number and size of the documents in your source data directory, the
conversion process may take some time; for larger data sources, you may want to run your conversion
process overnight. Converted images are saved in archive TIFF format with metadata preserved in the
file in MODS (Metadata Object Description Schema) format. For more information about MODS,
refer to the MODS website at the Library of Congress: http://www.loc.gov/mods

12


http://www.loc.gov/mods

8.

When the conversion is completed, click the ResCarta Data Conversion Tool’s close window
button. 4

Note: The ResCarta Data Conversion Tool creates the following directory structure under your
RCDATAOL1 (destination directory, as specified in step 5): institution identifier/aggregator/root
identifier. These three terms, which comprise the object identifier for a particular document, are
defined when you use the ResCarta Metadata Creation Tool (see step 9, page 7). For example, if
your Id is brookhav, your Aggregator is 00000001, and your Root id for a particular document is
00000026, the following directory structure appears for that document under your RCDATAO1
destination directory: brookhav/00000001/00000026.

Data Conversion tool “Document by file” mode:

6.
7.

The Document by file mode of the Data conversion tool allows for the conversion of multipage PDF
files into Rescarta objects. It can convert multipage NORMAL PDF files which is new for the toolkit.

NORMAL PDF files contain fonted text and do not contain a complete raster image of the document
page. The ResCarta tool will need the assistance of GHOSTSCRIPT to convert the fonted text data
into TIFF raster format. This process used to be known as a RIP (“Raster Image Processor”) which
prepared Postscript files for printing on raster laser printers. You can download GHOSTSCRIPT
from http://pages.cs.wisc.edu/~ghost/doc/GPL/

Proceed with the first five steps from the previous section. Then
Select Source data type as “Document per file” from the pulldown.
Now you have the option of using individual metadata.xml files created earlier using the Metadata

Creation tool or apply a set of standard metadata to all the files in the directory. Select the Source
metadata type of “Apply default metadata to all documents”.

8.

Now proceed to set the default metadata to be used. Enter the Institution Id for these documents.

Enter the starting Aggregator and Root Id (see Metadata Creation tool on page 8 for more on this.)

9.

Set the Default metadata by pressing the Set button. You will be asked to Select the metadata type

(Monograph, Serial, Serial Monograph) and then press the Ok button. The Set default metadata dialog
will open (see page x) Enter the items which will be applied to ALL the documents in this directory. Then
press the Finish button at the bottom of the dialog.

10. If you would like the tool to extract existing metadata from the PDF files use the Misc Options check
boxes.

o Read PDF title will extract the title from the existing PDF and if not checked or not found will
replace the title with the file name from the document.

o Read PDF author will extract the author information if it exists else it will use the author
information entered in the Set default metadata dialog.

e Convert PDFs to color will convert ALL documents to full color else it will create bitone images.
e Show ghostscript output will display information from the RIP.
e Show date/time check box causes the status output to show the date/time for each message.

o Serial Options will be grayed out for Monographs. If you are converting a number of Serials you
can use the spinners to set the Starting volume number, Starting issue number and the length of
the padding on the Volume and Issue strings. You may also choose to increment the volume or
the issue per each file encountered.
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11. Error handling can be controlled from the three check boxes.
e Continue on error does just that. The program will continue when it encounters an error.

e Write error log check box will write a log of any files it has problems with or errors encountered
during conversion.

e Separate problem documents check box will create a new directory below the existing working
directory and move any problem files into that directory.

Press the Begin conversion button when you have completed your selections. The program will show the
status of the conversion in the lower pane. You may copy this status information using the operating
system’s copy/paste key combinations.

ioix
~Source data directory -  Destination directory -
ClcustomenjobsikrcigovDoes [..]| carcoaTan L]
-.Suurce data type - -
"Ducumem per file | - ‘
Source metadata type : | rDefault metadata
l‘npply default metadata to all documents | b ‘ | Serial | Set | ‘ Clear ‘
rInstitution id 7 Agaregator and starting root id - :
brogkhay ||| | ngaregator 20101203 | Rootid [nooooooT |
.- Misc options : Serial options :
Read PDF title Show ghostscript output Starting volume —|  Startingissue | 11—
Read PDF author [ | Show dateftime Volume padding _Si Issue padding 4
[] Convert PDFs to color [ ] Increment volume Increment issue

rError handling-

Continue on error Write error log Separate problem documents

¥ Begin Conversion

Status

Witing ResCarta document metadata. . (Finished)
| Conversion operation successfully completed: Dec 3, 2010 3:40:33 Al

4|r
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ResCarta Textual Metadata Editor

Use the ResCarta Textual Metadata Editor to add, edit, or delete textual metadata (searchable words
that are stored with document images) to ResCarta-formatted documents. Any documents that were
scanned without OCR (Optical Character Recognition) need textual metadata, or they cannot be located in
searches conducted with ResCartaWeb. You may also want to add searchable text to photograph pages in
documents, or to edit existing textual metadata in OCR-scanned pages.

Note: You must use the ResCarta Data Conversion Tool (see page 11) before using the ResCarta
Textual Metadata Editor.

To add or edit textual metadata:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta
Textual Metadata Editor.

Note: The version number of the ResCarta Textual Metadata Editor is also included as the last part
of its Windows Start menu option name, but is not included in this document.
The ResCarta Textual Metadata Editor appears.

EBRrescarta Textual Metadata Editor v1.0.6 L 10l =|
File Utilities

Pages

Words

2. From the File menu, select Open ResCarta object directory.
The Select ResCarta object directory dialog appears.

15



3. Enter or browse to the ResCarta object directory (document directory; the lowest level of directory
structure in documents that have been converted to ResCarta format) in which you want to add or edit

textual metadata and click Select ResCarta object directory. |_Select ResCarta object directory |

Note: If you used the ResCarta Data Conversion Tool to convert your data in the ResCarta format,
the following directory structure exists under your RCDATAQOQ1 (destination directory, as specified in
step 5, page 11 in the ResCarta Data Conversion Tool section): institution
identifier/aggregator/root identifier. These three terms, which comprise the object identifier for a
particular document, are defined when you use the ResCarta Metadata Creation Tool (see step 9,
page 7); they also define your ResCarta object directories.

4. The ResCarta Textual Metadata Editor now displays a list of Pages in the document within the
ResCarta object directory you selected (in the upper left pane) and the existing textual metadata

(Words) for the current page (in the lower left pane). The rest of the tool displays the current page (in
the right pane).

5. To select a page, click its number in the Pages list. Any textual metadata (Words) that exists for that
page is listed and selected (In the words pane). The page display (in the right pane) highlights any of
the Words for which coordinate location values exist, as shown in the following example:

C:RCDATAO1'brookhaviHWO00000310002STAT - ResCarta Textual Metadata Editor -
File
Pages
|=| 000A
El oooB — .
~ 0001 : AX ILLUSTRATED HISTORY
El 0002 =

£l 0003 iaagn 1A 3 J

El o004 [HE STATE OF WISCONSIN.
= 0005 i -

=/ 0006 £ A OUMPLETE CIVIL, POLIFICAL, AND WILTTARY HISIORY OB
|=/ 006A i THE STAIR,

=/ oo6B :

o w R

mD

4]

Words

© AN

@ ILLUSTRATED
@ HISTORY

© OF

@ THE

© STATE

© OF

© VWISCONSIN.
© BEING B
@ A —| S

SOLD OWLY BY CANVASSING AGENTE

mD

ILLUSTRATED.

FUBLISHED BY B. B. RUSSELL, BOSTON, MASS.
MADIHON, WIR B B EUBHELL & 00
1875,

Note: The page display area includes some of the same viewing options that are available in the
ResCarta Metadata Creation Tool’s viewer (for more information, see page 7).

6. To add textual metadata, use the insert button that indicates the location you want to place your new
word in the list of Words:

Tip: If the order of words in the textual metadata (and in the Words display list) is not important to
you, it is immaterial which insert button you use; the order of the words is not relevant to their
coordinate positions, if any are specified at all.

e To add a word before another word, select the existing word (the word before which you want to
insert a new word) and click Insert before. ﬁ

16




e To add a word after another word, select the existing word (the word after which you want to
insert a new word) and click Insert after.

e Toadd aword on a page that doesn’t yet include any words, click Insert.

Note: If the current page doesn’t yet include any words, the Insert button replaces the Insert before
button; if more than one word is selected, Insert before and Insert after are not available.

The Insert word dialog appears. Enter the information for the word you’re inserting:

Insert word

Word |

Font name |

|

|

Point size [0 |
X1o |
|

|

|

¥1o
x2[o
v2[o

| Finish | | Cancel |

Tip: Only the Word and a Font name are required to store your word as textual metadata associated
with the current page; all other information is optional. However, words for which X1, Y1, X2, and
Y2 values are not entered cannot be highlighted during searches of your collections.

e Enter the Word you’re inserting.
o Enter the Font name that was used to render the word on the page.

Tip: If you don’t know this information exactly, enter the font name that best approximates the
displayed font (e.g. Helvetica, Times-Roman).

e Enter the Point size of the word on the page.

Tip: The Point size is currently reserved for future use; if you don’t know this information, enter
the point size that best approximates the displayed size.

Note: X1, Y1, X2, and Y2 are measured in pixels at 72 DPI, with the lower left corner of the page as
the origin.

e Enter the X1 coordinate of the word (lower left X coordinate).

e Enter the Y1 coordinate of the word (lower left Y coordinate).

e Enter the X2 coordinate of the word (upper right X coordinate).

o Enter the Y2 coordinate of the word (upper right Y coordinate).

To edit textual metadata for an existing word, select the word you want to edit and click Modify.

Note: If the current page doesn’t yet include any words or more than one word is selected, Modify is
not available.

The Modify word dialog appears. Enter the information for the word you’re modifying (refer to the
preceding step for more details on the information that’s required in this dialog).

To remove a word from the current page, select the Word you want to remove and click Remove.

The Confirm word removal window appears. Click Yes to remove the word from the
current page; click No to cancel the word removal process.
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9. When you’re finished adding and editing textual metadata, click the ResCarta Textual Metadata

Editor’s close window button. 2 The confirm exit window appears. Click OK to exit; click Cancel
to return to the ResCarta Textual Metadata Editor.

The Utility menu.

The Utility menu contains an item called “Correct ABBYY OCR”. This menu item was only used for
data converted by the ABBYY OCR program version 8.00 and converted with earlier versions of
the ResCarta Data conversion tool. In this version the data exported by the ocr package in PDF output
stripped the last character of each word from the end of the word. This caused the ResCarta Data
conversion tool to create a separate word for the last character of each word in a document. So the phrase
*“ exact artist, made even important errors” in the page below would be rendered as “exac”, “t”, “artist”,
“7, “eve”, “n”, “important”, “t”, “error”,”s” in the ResCarta word list. Searching for the phase “exact
artist” would still work because ResCarta Web would concatenate the “Four” words “exac”, “t”, “artist”,

" . See the page below for an example.

E C:'customerijobs'\RCsampleData'RCDATAO 1'rescarta'L DO0000 11d31i797 - ResCarta T... o = E
File Utilities
Pages-
£ rRoo1 1]
= ROO2
El roo3 Re
= i ift FORTRAIT, THE CHAPMAN FO
= 0133 :in, considered very good. A Which bears the inscription, el
= 0134 ‘er French artist, resembles Act directs, August
= 0135 : L || e
= 0136 WHICH IS PAUIL | [, |
= 0137 || “hese portraits, all dating back to the vears just after the Revolu :
= n13e il r
#|PEE=s| heter, and of the chin and the rest which as- T | @ |
Bt || ‘bincidences. The agreement was within one ii Fe —
© exac ~||| :/hile artists always take exact measures, they I@\|
ot ‘Inin order to emphasize some characteristic, P™Y || ™8|
@ artist =l | ke rge_i!]_imelers from the real measure. Thus, &V || |
e, )| ey mat artist, made even important errors; pos || %]
® mad ‘sure some of his portraits and compare them  for—
ee ‘brified that he made changes or exaggerations
® e :f sometimes he did not notice. [ have never
FH “rn artist’s work so exact a relation between
!l i} that which I found between Houdon's bust ’I
@ importan =| | ‘torpse I was examining.”
oy o
1541 words | | : 5
S i, is the proof as to the identity of the body i
2. Joserbelore ‘htes Government believes to be that of the J%f
&' Insert after ‘fhe Stars and Stripes over an ocean vessel, and Xy
55 Modify ‘merica feared and respected on all seas by his d;"
lake and the Serapis. To the Louisville Con- 19
¥ Remove ‘lof is “complete and mnvin|cin;:‘-." But Mr. 9%~
s BN 1l 3

Note: This menu item has now been disabled since all problems with versions of ABBY'Y have been
corrected within the Data conversion tool .
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ResCarta Collections Manager

Use the ResCarta Collections Manager to manage your ResCarta collections. Any change you want to
make to your collections, such as adding or removing documents, is managed through this tool.

Important! You should copy your ResCarta data from its intermediate location to your ResCarta database
(its intended final location) before using the ResCarta Collections Manager. Use a file manager (such as
Windows Explorer) to locate your intermediate RCDATAOQ1 folder, and copy the directory or directories
immediately beneath this folder (your institution identifier directory, as specified in the ResCarta
Metadata Creation Tool section, step 9, page 7; if you’ve used more than one institution identifier, you
will have more than one directory to copy) to the same directory level of the computer on which your
ResCartaWeb database is stored (immediately beneath the RCDATAOL folder).

Note: After making any changes to your ResCarta collections, objects (ResCarta-formatted documents),
or metadata, the ResCarta Indexer must be run to update the index (see page 26).

To manage your ResCarta collections:

Note: The following information is also accessible from within the ResCarta Collections Manager; from
the Help menu, select Help contents.

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta
Collections Manager.

Note: The version number of the ResCarta Collections Manager is also included as the last part of
its Windows Start menu option name, but is not included in this document.

The ResCarta Collections Manager appears.

BB Rescarta Collections Manager v1.5.1 1 o ]

File View Help

Collections

2. To open a ResCarta Data Directory:
Note: The ResCarta data directory will be named RCDATAOQ1(uppercase).
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e From the File menu, select Open ResCarta volume.
The Select directory dialog appears.

o Enter the path to the directory that contains the data you want to work with in the File Name box
or browse to the directory and then click Select directory.

Note: If you have a large number of ResCarta documents in the directory you’re opening, you
may notice a delay as the documents are accessed.

o After the ResCarta Data Directory you selected opens, a dialog appears to inform you that it
opened successfully and details the number of ResCarta objects that were found there. Click OK
to close this dialog.

3. The ResCarta Collections Manager displays Collections in the volume you selected (in the left
pane) and information about the current collection (in the right pane).

Note: Collections are indicated with a stacked book icon = (in the left pane). Objects (documents) in

collections are indicated with a book icon “* (in the right pane), with the total number of documents
in the current collection displayed at the bottom of the Objects list.

Tip: To copy an object identifier (see step 9, page 7) or the complete path to an object, move your
mouse pointer over the object for which you want to copy information and right-click; from the menu
that appears, select Copy object id to clipboard or Copy path to clipboard, respectively.)

4. To create a collection:
e Click the Add button in the Collections pane on the far left of the ResCarta Collections

Manager.

The Add collection dialog appears.

Add collectiol

Title

Abstract

o Enter the Collection title you want to use, enter an abstract of the collection and then click the
Finish button.

Note: The collection title can contain letters, numbers, and/or spaces.

Your new collection title appears in the Collections list and the total number of objects in the current
collection is displayed at the bottom of the list.
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5. To add objects to a collection:

Select the collection you want to add objects to in the Collections pane (on the left side of the
ResCarta Collections Manager).

Objects in the selected collection are displayed on the Collection content tab (in the right pane); the
total number of objects in the current collection is displayed at the bottom of the Objects list.

Tip: Use the View drop-down at the bottom of the Objects section to display objects by Title or Id
(object identifier; see step 9, page 7).

On the Collection content tab, click the Add button under the list of Objects that are currently
included in the collection.
The Add Obijects dialog appears, listing all available data in the current ResCarta Data Directory);

the total number of objects with respect to the current Filter (see the following tip) is displayed at
the bottom of the Objects list.

Add objects
Objects : Monograph sl
> 28th Regt. Infantry Penna. |~ || | Title

@ A Soldier's narrative.
€ A brief history of the One H
@ A fair statement. The true
@ A letter to a friend in a slay
@ A replyto Mr. Charles Inge| ||
@ About the war : plain word m
@ Abraham Lincoln :
@ Abraham Lincoln : a memcg B
@ Address by the Union leag A1e
@ Address of the Democrati :
@ Address of the Union Leag
@ Address of the Union State || | o o

@ Against the immediate res{ ||

@ American freedman (New Type

@ An oration delivered onthe_ | R

Lrennrt of the Farr;nl -

D

28th Reat. Infantry Penna. Volunteers : Coldstream Regiment.

| rArernative titles

Authors

@n
m

177 objects | -
Wiew |Title - Genre

authority

Filter |Mot in current collection hd

4]

L —blicbhar pasan

Note: Metadata for the currently selected object is displayed (in the right pane of the Add Objects
dialog) for reference; this information can be edited after the object is added to a collection (see
the following step). The page display area (at the bottom of the right pane of the Add Objects
dialog) includes some of the same viewing options that are available in the ResCarta Metadata
Creation Tool’s viewer (for more information, see page 7).

Tip: Use the View drop-down at the bottom of the Objects section to display those documents by
Title or Id (object identifier; see step 9, page 7). Use the Filter drop-down at the bottom of the
Objects section to display All (all objects in the your ResCarta volume), Not in current
collection (only objects in your ResCarta volume that are not included in the current collection,
as shown in the preceding example), or Not in any collection (only objects in your ResCarta
volume that are not included in any collection).
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Select the object or objects you want to place in the collection.
o Toselect asingle object, click it.

o To select multiple objects that appear adjacent to one another in the list, press and hold the
Shift key as you click the first and last of the adjacent objects you want to place in the
collection; the rest will be selected automatically.

o To select multiple objects that do not appear adjacent to one another in the list, press and hold
the Ctrl key as you select the objects you want to place in the collection; you must click each
individual object you want to select.

Click Finish to add the selected object or objects to the collection.

Note: You may add the same object to more than one collection; the metadata will be maintained
independently.

6. To remove an object from a collection:

Select the collection you want to remove an object from in the Collections pane (in the left pane).
Obijects in the selected collection are displayed (in the right pane, in the Collection content tab).

On the Collection content tab, select the object you want to remove from the list of Objects that
are currently included in the collection and click the Remove button under the list.

The Confirm object removal dialog appears to confirm the object you want to remove, and the
collection you want to remove it from.

Click Yes to remove the object from the collection. Click No to close this dialog without
removing the object from the collection.

Note: Removing an object from a collection does not remove it from its original location in the
ResCarta Data Directory.
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7. To modify object metadata:

Note: Changes made to metadata in one collection do not occur in that same object in other
collections. Size width, Size height, Issues, and Pages cannot be modified using the ResCarta
Collections Manager.

e Click the object for which you want to edit metadata, and then click the Modify button in the
Objects pane.

The Modify Object dialog appears.

Modify object -
Monograph
Title

|Winnebag0 County, YWiscansin

Alternative titles
@ Winnebago county

oF Add

Authors
@ Thwaites, Reuben Gold

oF Add

Owner

| e[ 7]

Type of resource

ftext |~

Genre

Note: Use the scroll bar on the right to navigate to the fields you want to modify.

e To modify Title, Volume (for serial monograph or serial documents only), Owner, Genre,
Genre authority, Publisher name, Place of publication, Publication date, Capture date,
Language, and Note metadata, select the field you want to change and make the changes directly
to the field in the Modify Objects dialog.

o To modify Owner Type, Type of resource, Language authority, and Language type, choose
from the options in the drop-down list in the Modify Objects dialog.
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o To modify Alternative titles, Authors, and Subjects metadata, use the Add, Modify, and
Remove buttons located under the field you’re modifying.

o Toadd information:
Click the Add button under the field to which you want to add information.
The Add dialog appears for the metadata you selected.

Add subject
Subject type
@ Topic ) Geographic
Authority
Topic
Country
State
County

Enter the information you want to add to the field and click Finish. To close this dialog
without saving your changes, click Cancel.

Note: When you’re adding Subjects metadata, you must first select Subject type (Topic or
Geographic). For Topic type metadata, enter Authority and Topic information. For
Geographic type metadata, enter Country, State, and County information.

o To edit existing information:
If multiple lines of information exist for the metadata you want to change, select the specific
line you want to modify and then click the Modify button under the field.

The Modify dialog appears for the metadata you selected.

Modify subje

Subject type
2 Topic ® Geographic

Authority

Topic

Country
[Usa |

State
fi |

County
|Winnebag0 |
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Make the changes to the information that you want to include in the field and click Finish. To
close this dialog without saving your changes, click Cancel.

Note: When you’re changing Subjects metadata, you may need to change Subject type
(Topic or Geographic). For Topic type metadata, you can change Authority and Topic
information. For Geographic type metadata, you can change Country, State, and County
information.

To remove information:

If multiple lines of information exist for the metadata for which you want to remove
information, select the siecific line you want to remove and then click the Remove button

under the field.

The Confirm removal dialog appears for the metadata you selected, to confirm the
information you want to remove. Click Yes to remove the information. Click No to close this
dialog without removing the information.

When you’ve finished modifying metadata, click Finish to save your changes. To close this
dialog without saving your changes, click Cancel.

8. To save your changes to your ResCarta collections, from the File menu, select Save collections data.

Tip: When you’re making a large number of changes, save your changes periodically rather than
waiting to save your changes when you exit the ResCarta Collections Manager.

9. When you’re done managing your ResCarta collections, click the ResCarta Collections Manager’s

close window button. B The confirm exit window appears. Click OK to exit; click Cancel to return
to the ResCarta Collections Manager.

Note: If there are changes to your collections that you haven’t yet saved, you will be prompted to save
those changes before exiting the ResCarta Collections Manager.

10. Saving Dublin Core Metadata. You can now save your metadata in Dublin Core formatted xml files
for use in other systems. From the File menu, select Dublin Core Preferences. The Dublin Core
Preferences dialog appears.

To Create OAI_DC xml files for use in |
your OAI provider software.

1.

[¥] Write DC metadata

Set the output directory to a
centrail location.

Enter the path of the output
directory.

Select OAI_DC as the output
format.

Enter the url of your ResCarta
—Web site complete with the
trailing slash.

Press the Ok button

Answer Yes to the write dialog.

Output directory mode

|0utput to a central location

Output directory

|uF' rodsererdIwvaulfioal_DCSC

Output file naming

Output filename

Output format

iom_Dc

ResCarta-Weh URL

|htlp St TS Bree . orgd

I Ok || Cancel |
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ResCarta Indexer

Use the ResCarta Indexer to create a Lucene™ index of your ResCarta collections. Any changes you
make to your collections (using the ResCarta Collections Manager; see page 19) requires that a new
index be built so that ResCartaWeb can accurately search the collection.

Important! Indexing a collection can be a time-consuming process, particularly in larger collections; the
ResCarta Foundation recommends running ResCarta Indexer over a weekend.

To create Lucene indexes of your collections:

Note: The following information is also accessible from within the ResCarta Indexer; from the Help
menu, select Help contents.

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta
Indexer.

Note: The version number of the ResCarta Indexer is also included as the last part of its Windows
Start menu option name, but is not included in this document.

The ResCarta Indexer appears.

Brescoriomnderervios laix
File Help )
ResCarta data volume directory Index destination directory
CARCDATADT [.] | carcoaTADndex ar2 [.]
Options

[#] Rebuild index ¥ Begin Indexing

[_] Optimize index

Status

| »

[4]

4] [»]

If you’re creating an index for a ResCarta collection for the first time, set your Source data directory
and Index destination directory and then click Begin indexing. The indexing process will begin and
its status will be displayed in the Status window.

If you’ve made structural changes to your ResCarta collection metadata at the collection level (for
example, adding or removing a collection) or object level (for example, adding or removing a book
from a collection), you can also proceed to Begin indexing (see step 5) as soon as you’ve set your
Source data directory (see next step) and Index destination directory (see step 3).
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Other changes to the ResCarta collection metadata may require using of indexing Options (see step
4).

To select the Source data directory:

e Click the button to the right of the Source data directory text field. [ - |
The Select directory dialog appears.

o Enter the path to the directory that contains the data you want to work with in the File Name box
or browse to the directory and then click Select directory.
Note: The ResCarta “source data directory” will be named RCDATAOL(uppercase).

To select the Index destination directory:

Important! ResCarta specifications require that indexes be stored in the index.ar2 (lower case)
subdirectory of the RCDATAOL(upper case) ResCarta data directory (/RCDATAOL/index.ar2). If
this directory does not yet exist, you must create it.
e Click the button to the right of the Index destination directory text field. [ - |

The Select directory dialog appears.
o Select index.ar2 subdirectory:

o Ifthe index.ar2 subdirectory already exists in the RCDATAO1 directory, enter the path to the
index.ar2 subdirectory or browse to the directory and then click Select directory.

Select directory

o Ifthe index.ar2 subdirectory does not exist in the RCDATAO1 directory, browse to the
RCDATAOL directory and then click the Create New Folder button (the third option to the

right of the Look in drop-down listbox).
New Folder appears in the RCDATAOL directory.

Type index.ar2 (lower case) and press Enter, and then click Select directory.
Select directory

To select indexing Options:

There are two options that may be used when indexing: Force rebuild and Force optimize on
change. To use either, or both, select the appropriate check box(es).

e Rebuild index

When you check Rebuild index, the ResCarta Indexer will build a new index even if an index
exists and there have been no changes in the data. For example, if your index becomes corrupted,
you need to use Rebuild index to create a new index.

You will also want to use Rebuild index when you have used the ResCarta Collections
Manager to change metadata for any of the objects in your collections. For example, if you
change the title of a book or the subject, you must run the ResCarta Indexer with the Rebuild
index option checked to create an index that reflects the changes.

e Optimize index

When you first build an index for a collection, the indexer automatically optimizes the index; you
do not need to check Optimize index the first time you build an index for a collection.

However, when you update an existing index, you must check Optimize index to optimize the
index. Optimizing an index can take longer than building an index without optimizing, but it
improves index performance.

27



5. The progress of the indexing process is detailed in the Status (lower) section of the ResCarta
Indexer.
6. When indexing is complete, click the ResCarta Indexer’s close window button. 2

Setting Preferences. From the FILE menu, select Preferences. The Indexing Preferences dialog
appears.

Indexing Preferences | x|

[ ] Output indexing performance data

[] Strip underscores from indexed text

Index glob size | 1GE_I'E!

i ok || Cancel |

The Output indexing performance data check box will increase the amount of information shown
by the indexer. Normally you would see output like the following...
Indexing object: WISC-0CLC/0clc2010/20101101/00000059(0,108 of 0,113)...(Done, 1 pgs)
Indexing object: WISC-0CLC/0clc2010/20101101/00000060(0,109 of 0,113)...(Done, 1 pgs)
Indexing object: WISC-0CLC/0clc2010/20101101/00000061(0,110 of 0,113)...(Done, 19 pgs)
Indexing object: WISC-OCLC/wionrfi0/20100922/00001739(0,111 of 0,113)...(Done, 13 pgs)
Indexing object: WISC-OCLC/wionrfi0/20100922/00001740(0,112 of 0,113)...(Done, 3 pgs)

With the performance data checked you will see the following for each item indexed...

Indexing object: WISC-OCLC/wionrfi0/20100922/00001739(0,111 of 0,113)...(Done, 0,013 pgs,
000.0 sec, 00.000 sec per pg, heap 0,041.4MB, free 0,009.6MB)

The Strip underscores from indexed text check box option will do just that.any underscores in your
data will be removed and replaced by a space. This has been added for converting data using the
ResCarta Data Conversion tool where the original file names of the source files contained the title and
underscores were used to separate the words.

The Index glob size spinner can be used to increase the size of each index part. The index created
will be broken into parts when it exceeds the size set here. To date the index glob size has been set to
1 Gigabyte to maintain compatability with all modern operating systems. With large collections (4
million images or more), and using 64bit operating systems in servers with lots of memory there is a
performance enhancement when the glob size is increased .
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ResCarta Checksum Verification Tool

Use the ResCarta Checksum Verification Tool to verify TIFF checksums (computed values of data that
are compared to ensure data accuracy) of your ResCarta-formatted data, to ensure the integrity of the
documents in your ResCarta database.

Note: You can use the ResCarta Checksum Verification Tool at any time after the data has been
converted into ResCarta format. For more information on converting image data into the ResCarta
format, refer to the ResCarta Data Conversion Tool documentation (see page 11).

To verify TIFF checksums of your ResCarta-formatted data:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you
specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta
Checksum Verification Tool.

Note: The version number of the ResCarta Checksum Verification Tool is also included as the last
part of its Windows Start menu option name, but is not included in this document.

The ResCarta Checksum Verification Tool appears.

ResCarta data volume directory
CARCDATADT

|—| | ( Begin Verification |

Status

2. Click the button to the right of the Source data directory text field to specify the directory in which
your source objects are located. [ |

The Select directory dialog appears.

3. Enter or browse to the Source data directory (the directory in which the data for which you want to
check accuracy is stored) and click Select directory.
Tip: You may wish to check both the RCDATAOL1 directory on the computer on which your ResCarta
database is stored and the RCDATAO1 directory created by the ResCarta Data Conversion Tool

(see page 11), to ensure the accuracy of your final and intermediate data, respectively; these
verification processes must be run separately.
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4. Click Begin verification, | Beginverication |

The progress of the verification process is detailed in the Status (lower) section of the ResCarta
Indexer, and you will be notified of any problems with your data.

Note: The Begin verification button is replaced by the Cancel verification button during the
verification process; click Cancel verification at any time to stop the data-accuracy check.
| ¥ Cancel verification |

5. When verification is complete, click the ResCarta Checksum Verification Tool’s close window
button. 24

Data Format Update Tool
A utility for bringing older ResCarta Collections up to date with the 2.3.1 toolkit.

With the release of this version of the ResCarta Toolkit, we have updated our METS implementation.
In doing this we made changes to the way the ResCarta Collections Manager stores its METS
metadata. If you have an existing ResCarta collection and want to add to this collection using the
new ResCarta Toolkit version 2.3.1, you will need to run this Update tool ONCE against your
existing collection. Please note that the utility allows you to revert your collection to a pre 2.3.1 state.
If you run the tool more than once it will do no harm to your data.

Start the Data Format Update Tool and select the location of your ResCarta Data. Set the Target
format to 2.0 and press the Begin Update button. The status of each file changed will be displayed in
the status window frame.

[ rescert Data Format update Toolvins _aix)
Data directory Target format
CARCDATAN Ll ©10 ®20

| {* Begin Update |

Status
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Uninstalling the ResCarta Toolkit

To uninstall any or all of the tools in the ResCarta Toolkit, complete the following uninstallation
sequence for the tool or tools you want to remove from your computer.

To uninstall the ResCarta Toolkit:

1. From the Windows Start menu, select Programs, then select ResCarta Tools..

2. From the list select Uninstall ResCarta Tools. The tool’s Uninstall window opens and the process
of removing the tool from your computer begins.

¢ IzPack - Uninstaller - 0] x|

I::' This will remove the installed application!

[~ iForce the deletion of C:\Program Files\ReTools
{5 Uninstal | € Quit |

3. If you intend to use ResCarta Tools in the future, please uncheck the “Force the deletion of “ the
ResCarta tools directory. By doing this you can retain your institutional indentifier and the next object id
numbers. Click Uninstall to continue and remove the software or click Quit to stop and exit the
uninstaller without removing software from your hard disk.

A note about Errors:

We work hard to create world class software, but in the event that you encounter an unexpected error, a dialog box
should appear and give you futher instructions. If you get a blank dialog box (just and empty dialog) please note
what you were doing and send the contents of the error log to the ResCarta Foundation at info@ rescarta.org

This will help us make better tools for you and everyone else. You can find the errors logs under your user directory
like...

C:\Documents and Settings\{user name}\.RcTools\logs
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Glossary

The following terms and definition are used in relation to the ResCarta Toolkit:

Aggregator — The aggregator is a required identifier used to limit the number of ResCarta object folders
in a single directory within the same source institution parent directory; it must be eight characters (letters
and/or numbers) in length. You are required to supply an aggregator (or accept the preselected default)
when you use the ResCarta Metadata Creation Tool to add metadata to a document.

Checksum — A checksum is an inspection of numeric values that accompany data, and is used to help
determine the integrity of that data.

Destination Directory — The destination directory is the directory into which your converted documents
will be placed when you use the ResCarta Data Conversion Tool.

Metadata — Metadata are structured data that describe a document in your collection. For example, title,
volume, author, subject, etc.

Monograph — A monograph is a publication that’s complete as first issued, in one entity. Examples of
monographs include books and maps.

Object Identifier — The object identifier is made up of the source institution identifier, aggregator, and
root identifier. This directory structure (institution identifier/aggregator/root identifier) uniquely
identifies each ResCarta object in your database, and is referenced in the ResCarta Metadata Creation
Tool, the ResCarta Data Creation Tool, the ResCarta Textual Metadata Editor, and the ResCarta
Collections Manager.

Parent Directory — A parent directory is the directory that is one level up from the current directory.

Required Identifier — A required identifier is information that must be entered for one or more tools in
the ResCarta Toolkit to function.

ResCarta Database — The ResCarta database is the organized collection of all of your digital objects.

ResCarta Object — A ResCarta object is any document, book, photo, recording, etc that has been created
or converted to a digital representation according to the ResCarta standards. This term is referenced by
every tool in the ResCarta ToolKkit.

ResCarta Volume — A ResCarta volume is a collection of ResCarta objects, stored according to the
ResCarta standards. This term is referenced in the ResCarta Collections Manager.

Root Identifier — The root identifier is a required identifier used to distinguish the directory in which a
digital object resides; it must be eight characters (letters and/or numbers) in length. You are required to
supply a root identifier (or accept the preselected default) when you use the ResCarta Metadata
Creation Tool to add metadata to a document.

Sequential Naming Convention — A sequential naming convention is one in which names are numeric,
and increase sequentially. For example, 00000001, 00000002, 00000003, 0000004, etc.

Serial — A serial is a publication that’s issued in successive parts, usually numbered, and continuing
indefinitely. Examples of serials include periodicals, newspapers, and annual publications.
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Serial Monograph — A serial monograph is a publication that’s complete, or intended to be complete, in
a finite number of individual parts. Examples of serial monographs include a three-part book, or a ten-
report serial.

Source Data Directory — The source data directory is the directory in which the documents you want to
convert are stored when you use the ResCarta Data Conversion Tool.

Subdirectory — A subdirectory is a directory that is one level down from the current directory.

Source Institution Identifier — The source institution identifier is a required identifier used to define the
institution from which a document originated; it must be eight characters (letters and/or numbers) in
length. You can use multiple source institution identifiers with your ResCarta database. You are required
to supply a source institution identifier when you use the ResCarta Metadata Creation Tool to add
metadata to a document. The ResCarta Foundation suggests the use of an existing registered 1D (e.g.
Library of Congress MARC organization code, Staatshibliothek zu Berlin, The British Library,etc.) as
the identifier, if one exists for your institution. If the normalized length of the identifier is less than eight
characters, then padding with numeric zeros is suggested. You can search the Library of Congress
MARC code list at the following url. http://www.loc.gov/marc/organizations/org-search.php You can
also add an identifier to the code list by following instructions found at the following url.
http://www.loc.gov/marc/organizations/orgshome.html#requests
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Technical Support

For questions about the ResCarta Toolkit, please refer to the ResCarta Foundation’s
website (http://www.rescarta.org) or contact the ResCarta Foundation directly via email
(info@ResCarta.orqg).
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